Abstract
WIFI Control Car — Arduino Concept

“We built the car employing a variety of transmission methods. But what about a car that can be

controlled over WIFI.”

WIFI is the most promising technology right now, and developers are always working to improve
it. This technology is prevalent today and will be for many years to come. WIFI with low power
consumption has also been developed. So let us concentrate on this technology today. We created
a car that can be controlled via WIFI. If you host your IP address on a website, you can control it

from anywhere in the globe, but we'll stick to local WIFI for now. So, let's get started.
About the Node MCU and the Car

Node MCU is an ESP-32S microcontroller (MCU) similar to the 328P, except it has WIFI
incorporated into the ESP-32S. This is a fantastic resource for IOT newcomers. It can connect over
WIFI and can function as a Hotspot. See the diagram above for the pinout. In the Arduino code,

the GPIO numbers will be used.

Now, in this situation, the Node MCU connects with my router and generates a local IP address,
which we can enter into our mobile device or computer (both of which are linked to the same
router) to see a webpage appear with various buttons that allow us to operate the automobile. You

can now control the car with the help of the website.
Connections and Uploading Code

Setup your chassis. Connect motors, wheels, and the caster wheel with screws. Solder wires with

motors and connect them to sockets of the driver.

See the figure above and connect. Connect your motors as per your configuration. If you are
connecting your motor for the first time with the L298N driver then at a first run a code for moving
forward with the UNO. Then give a try to the right and then left. Backward will follow it. It will
be just a case of digitalWrite(). Comment freely if you are not okay. Power is required for the Node
MCU as well as the L298N. It will be better by using a different supply for the two things. Give
5V from the power bank at the Vin and GND of Node MCU. You can use 9V or 12V for L298N.



The whole process is rather easy. See the pictures given in the report and refer to the pinout pic of

Node MCU. You will understand it better.
Opening Browser

Get into the website from your device browser. You can see the following webpage. It has already
been a host on a free domain site. Press any button and run the car, if not running, check the power
supply given and for any loose connections happening. Do not give Node MCU beyond 5V. You
can use 12V for the L298N. So now, you can enjoy riding the WIFI-controlled car.

Introduction
Microcontrollers

Microcontrollers are everywhere around us, even when we drive our vehicles, on all computers we
use including smartphones and tablets, or sometimes when making a cup of coffee on our coffee
machines. With the rapid spreading of IoT technology, data is constantly being gathered,

microcontrollers have become a huge part of the modern world with a lot of fields of application.
What is a Microcontroller?

A microcontroller which is also called an MCU or Microcontroller Unit is a single Integrated
Circuit (IC) that is usually used for a specific application and designed to implement certain
specific tasks. This is a small computer based on a single metal-oxide-semiconductor (MOS)
integrated circuit (IC) chip. A microcontroller contains one or more CPUs or processor cores with
memory and programmable input/output peripherals attached to it. Program memory in the form
of ferroelectric RAM, NOR flash, or OTP ROM is also often included on this chip, as well as a
small amount of RAM along it.

“Microcontroller” is a well-chosen name for this apparatus because it emphasizes the defining
characteristics of this product category precisely. The prefix “micro” implies size or the smallness
of the device and the term "controller" here implies the enhanced ability of the device to perform
control functions. The functionality of this device is a result of a combination of a digital processor
and a digital memory with additional hardware components that are specifically designed to help

the microcontroller to interact with the other components.



Microcontrollers are wusually designed for embedded applications, in contrast to the
microprocessors which are used in personal computers or other general-purpose applications. They
are essentially simple miniature personal computers designed to control small features of a larger

component, without a complex front-end operating system.

A microcontroller is similar to but less sophisticated than, a System on a Chip (SoC). An SoC may
include a microcontroller as one of its components, but in addition, it is also integrated with

advanced extensions like a graphics processing unit (GPU), a Wi-Fi module, or coprocessors.

By reducing the size and cost compared to a design used on a separate microprocessor, memory,
and input/output devices, microcontrollers make it economical to digitally control even more
devices and processes very easily. Mixed-signal microcontrollers are very common. They function
by integrating analog components needed to control non-digital electronic systems. About the
internet of things and robotics, microcontrollers are an economical and popular means of data

collection, sensing, and actuating the physical world as edge devices.

Microcontrollers generally can retain functionality while waiting for an event like a button press
or some other interrupt. Other microcontrollers may serve performance-critical roles at which they
may need to act more like a digital signal processor (DSP) than a microcontroller, with higher

clock speeds and power consumption.

A microcontroller is also known as an embedded controller. Various types of microcontrollers are
available in the market with different word lengths. It is like a compressed microcomputer
manufactured to control the functions of the embedded systems in appliances machines used in
offices, robots, home appliances, motor vehicles. Microcontrollers are employed in devices that

need a degree of control to be applied by the user of the device in controlling it.

A microcontroller can be also defined as a small and low-cost microcomputer, which is designed
to perform the specific tasks of embedded systems like displaying microwave information,
receiving remote signals, etc. Any electric appliance that stores, measures, displays information,

or calculates comprises a microcontroller chip inside it.

What a microcontroller does is, gathers input, process this information, and outputs a certain action

based on the information gathered by it. Microcontrollers usually operate at lower speeds, around



the IMHz to 200 MHz range, and are designed to consume less power because they normally are

embedded inside other devices that can have greater power consumptions than the MCU.

A Microcontroller can be considered as the backbone of Embedded Systems and its most important
feature is the fact that "It can think". A Microcontroller may look like a simple electronics chip,
but it’s way too powerful because it's programmable. Using a programming code, we can control

all I/O pins of a microcontroller and are used to perform multiple functions.

C and assembly languages are usually used for programming a microcontroller but the HEX File
which gets uploaded in Microcontrollers is in machine language. There are also other languages
available for programming a microcontroller but beginners start with assembly language as it

provides a clear idea about the microcontroller's architecture.
History

The origins stories of both the microprocessor and the microcontroller go back to the invention of
the MOSFET, also known as the MOS transistor. Mohamed M. Atalla and Dawon Kahng at Bell
Labs invented it in 1959. Atalla also proposed the MOS integrated circuit, which was an integrated
circuit chip fabricated using MOSFETs. MOS had higher transistor density and lower
manufacturing costs than bipolar chips. MOS chips increased in complexity with time, leading to
large-scale integration (LSI) with hundreds of transistors on a single MOS chip. The application
of the MOS LSI chip was the basis for the first microprocessors when engineers recognized that a

complete computer processor could be contained on a single MOS LSI chip.

The first-ever multi-chip microprocessors, the Four-Phase Systems, and the Garrett Ai Research
MP944 were developed with multiple MOS LSI chips. The first single-chip microprocessor, which
was the Intel 4004, was released on a single MOS LSI chip.

Engineers Gary Boone and Michael Cochran created the first microcontroller in 1971. The TMS
1000, combined read-only memory, read/write memory, processor, and clock on one chip and

mainly targeted at embedded systems.

After that, Japanese electronics manufacturer began producing microcontrollers for automobiles,
including 4-bit MCUs for in-car entertainment, automatic wipers, electronic locks, and dashboard,

and 8-bit MCUs for engine control.



Nowadays microcontrollers are cheap and are also readily available for hobbyists, with large online

communities around certain processors.

A typical home in a developed country is likely to have only four general-purpose microprocessors
but around three dozen microcontrollers. A typical mid-range automobile has about 30
microcontrollers. They can also be found in many electrical devices such as washing machines,

microwave ovens, and telephones.
Types of Microcontrollers

Microcontrollers are classified based on Bus-width, Memory, Instruction Set, Architecture, &

Microcontrollers

Instruction Set

Manufacturer.

Bus-Width

Architecture Manufacturer

8-Bit

Embedded

Princeton

External Harvard

Arduino

g608 [

64-Bit
Types of Microcontrollers

Fields where Microcontrollers are used.
Microcontroller has many applications like:
* As a peripheral controller of a PC

* In robotics and embedded systems

* In bio-medical equipment

* In communication and power systems

* In automobiles and security systems



* When implanting medical equipment

* In fire detection devices

* In temperature and light-sensing devices

* In industrial automation devices

* In-process control devices

* When measuring and controlling revolving objects
ESP-8266

ESP8266 is a low-cost Wi-Fi chip produced by Espressif Systems.

ESP Modules

ESP-01 ESP-12

[ESP-12S]  [ESP-12F]  [ESP-12E]




ESP-8266 Chip Block Diagram

The functional diagram of ESPE2GE6EX is shown as in Figure 3-1.
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Figura 3-1. Functional Block Diagram

* Esp8266 has integrated a Tensilica L106 32-bit RISC processor. It got extra-low power

consumption, which makes this chip very much suitable for small circuits, IOT Projects.

* This chip reaches a maximum clock speed of 160MHz.
* Wi-Fi- 2.4GHz receiver & transmitter
 User programs are stores in SPI flash

* Memory - 32KB instruction RAM

 External SPI Flash 512KB to 4MB typically in some cases 16MB supported according to

the board you chosen




GPIO - 1/0O Pins in the Board
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PWM - way to reduce the power delivered by an electrical signal
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ADC-Analog to Digital Converter Converting analog inputs to digital signals

I2C is a serial communication protocol data is transferred bit by bit by a single wire (SDA Line).

SCL is the clock line. It is used to synchronize all data transfers over the 12C bus. SDA is the data

line.
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I2S is an electrical serial bus interface used to connect digital audio devices. Consists of a clock

line, word clock (left-right clock) line, and serial data line.
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SDIO (Secure Digital Input/Output Interface) - SDIO is used for Data exchange between host
and device. SDIO can connect the SD Slot with I/O devices like Bluetooth, Wireless LAN, GPS
Receiver, Digital Camera, etc.

SDIO Interface Bus:

Clock

CMD

Host Device
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Intro for Motor Driver
Pulse Width Modulation (PWM)

* In the PWM signal, the minimum and maximum voltage are the values that limit the
wave’s oscillation.

* The space between them is called amplitude.

* A cycle is the interval of the wave where you can find one full repetition.

* The time that takes a cycle to finish is called a period. Frequency =1/period

* Duty Cycle represents how much of the period in which the signal is high.

* To calculate the duty cycle you need to know how much of the period the signal is high.
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d) Signal D with 70% duty cycle

Calculating duty cycle = Take high time as 50ms and low time as S0ms

* Period is 100ms

* 50ms/100mx=50% duty cycle

50%
- Duty Cycle
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. 5v*50%=2.5v
Output=2.5v

Duty Cycle Resolution- Resolution is how many steps there can be between 0% and 100% in

ESP8266 it is 0-1023(10bit) and in Arduino, It is 0-255(8bit)



Binary to Decimal Bit Value Table
{8 Bits in a Byte)

128 64 32 16 8 4 2 1

1 1 1 1 1 1 1 1
(On) (On) (On) (On} (On) (On) (On) (On)

+128 +64 +32 +16 +8 +4 +2 +1

255

How PWM is controlled in Arduino-IDE

#defineENA D1//Defining PIN D1 is pin no in NodeMCU

analogWrite(ENA, Speed);

pinMode(ENA, OUTPUT);//choosing is ENA is input or output

L293D Motor Driver

. 111'1111

n—E"J | L ey
¥ INT &IN2 |

We can turn on and off the motor via ENA and ENB

A module usually comes with a jumper on those two pins when those are placed it is in ON state

and on maximum speed



After removing the jumpers, by giving PWM signals to ENA and ENB pins we can control the

speed of the motors

» VCC - voltage supply line for motors and the module (This module has a voltage drop of around
2volts, each channel can handle 2A)

* GND- Common pin

* 5V — it outputs 5V when a jumper is placed in 5V-EN (Also provide power for L298N IC through
a 7805 5v regulator when the jumper is removed you need to provide 5v externally)

* ENA- making this pin HIGH will make motor A rotate or by giving Desired PWM Signal
* ENB- making this pin HIGH will make motor B rotate or by giving Desired PWM Signal

* IN1 & IN2 — These two pins control the direction of motor A rotation when IN1 is High and IN2
is LOW motor A will rotate clockwise and when IN1 is LOW and IN2 is the HIGH motor will
rotate anticlockwise. If both pins are either HIGH or LOW motor will stop the spin

* IN3 & IN4 - These two pins control the direction of motor B rotation when IN3 is HIGH and IN4
is LOW motor A will rotate clockwise and when IN3 is LOW and IN4 is the HIGH motor will
rotate anticlockwise. If both pins are either HIGH or LOW motor will stop the spin

* OUT1&OUT?2 — Output for motor A
* OUT3&0OUT4 — Output for motor B

IN1 IN2 Direction

0 0 OFF

1 1 OFF

1 0 Forward

0 1 Backward !

Above is an XOR Gate (not in the datasheet)

Rotation Direction Changing

A
B

out
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Arduino Code

#define IN_1 15 // L298N inl motors Rightx GPIO15(D8)

#define IN_ 2 13 // L298N in2 motors Right GPIO13(D7)
#define IN 3 2 // L298N in3 motors Left GPIO2(D4)
#define IN 4 0 // L298N in4 motors Left GPIO0(D3)

#include <ESP&266WiFi.h>
#include <WiFiClient.h>

#include <ESP8266WebServer.h>

String command; //String to store app command state.
int speedCar = 800; /1400 - 1023.

int speed_Coeff = 3;

const char* ssid = "WIFI CAR 2";

ESP8266WebServer server(80);

void setup() {

pinMode(IN_1, OUTPUT);

pinMode(IN_2, OUTPUT);

pinMode(IN_3, OUTPUT);



pinMode(IN_4, OUTPUT);

Serial.begin(115200);

/I Connecting WiFi

WiFi.mode(WIFI_AP);

WiFi.softAP(ssid);

[PAddress myIP = WiFi.softAPIP();
Serial.print("AP IP address: ");

Serial.println(myIP);

// Starting WEB-server
server.on ( "/", HTTP_ handleRoot );
server.onNotFound ( HTTP_handleRoot );

server.begin();

void goAhead(){

digitalWrite(IN_1, LOW);

digitalWrite(IN_2, HIGH);



digitalWrite(IN_3, LOW);

digitalWrite(IN_4, HIGH);

void goBack(){

digitalWrite(IN_1, HIGH);

digitalWrite(IN_2, LOW);

digitalWrite(IN_3, HIGH);

digitalWrite(IN_4, LOW);

void goRight(){

digitalWrite(IN_1, HIGH);

digitalWrite(IN_2, LOW);



digitalWrite(IN_3, LOW);

digitalWrite(IN_4, HIGH);

void goLeft(){

digitalWrite(IN_1, LOW);

digitalWrite(IN_2, HIGH);

digitalWrite(IN_3, HIGH);

digitalWrite(IN_4, LOW);

void goAheadRight(){

digitalWrite(IN_1, LOW);

digitalWrite(IN_2, HIGH);



digitalWrite(IN_3, LOW);

digitalWrite(IN_4, HIGH);

void goAheadLeft(){

digitalWrite(IN_1, LOW);

digitalWrite(IN_2, HIGH);

digitalWrite(IN_3, LOW);

digitalWrite(IN_4, HIGH);

void goBackRight(){

digitalWrite(IN_1, HIGH);

digitalWrite(IN_2, LOW);

digitalWrite(IN_3, HIGH);



digitalWrite(IN_4, LOW);

void goBackLeft(){

digitalWrite(IN_1, HIGH);

digitalWrite(IN_2, LOW);

digitalWrite(IN_3, HIGH);

digitalWrite(IN_4, LOW);

void stopRobot() {

digitalWrite(IN_1, LOW);

digitalWrite(IN_2, LOW);

digitalWrite(IN_3, LOW);

digitalWrite(IN_4, LOW);



void loop() {

server.handleClient();

command = server.arg("State");

if (command == "F") goAhead();

else if (command == "B") goBack();

else if (command == "L") goLeft();

else if (command == "R") goRight();

else if (command == "I") goAheadRight();
else if (command == "G") goAheadLeft();
else if (command == "J") goBackRight();
else if (command == "H") goBackLeft();
else if (command == "0") speedCar = 400;
else if (command == "1") speedCar = 470;
else if (command == "2") speedCar = 540;
else if (command == "3") speedCar = 610;
else if (command == "4") speedCar = 680;
else if (command == "5") speedCar = 750;
else if (command == "6") speedCar = 820;

else if (command == "7") speedCar = §90;



else if (command == "8") speedCar = 960;
else if (command == "9") speedCar = 1023;

else if (command =="S") stopRobot();

void HTTP_handleRoot(void) {

if( server.hasArg("State") ){

Serial.printIn(server.arg("State"));

}

server.send ( 200, "text/html", "");

delay(1);



Web & App Interface Made to Send Commands
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Item Used Of Wifi Control Car

Nodemcu (Esp8266) L293d Motor Driver

Bo Motor Robot Chassis




Create the Chassis

Node MCU is an ESP-32S microcontroller (MCU) like the 328P but the thing is that it has WIFI
integrated into the ESP-32S. So excellent for IOT beginners. It can connect over WIFI and can
also create a Hotspot as well. See the pinout given in the pic above. The GPIO numbers will

be used in the Arduino code.

Now here, in this case, the Node MCU connects with my router and it creates a local IP and
we can enter that IP in our Mobile or computer (connected to the same router) and can see

a webpage coming and there will be certain buttons by which we can control the car.

Setup your chassis. Connect motors and wheels and the caster wheel with screws. Solder

wires with motors and connect them to sockets of the driver.

See the figure above and connect. Connect your motors as per your configuration. If you are
connecting your motor for the first time with the L298N driver then at a first run a code for
moving forward with the UNO. Then give a try to the right and then left. Backward will follow
it. It will be just a case of digitalWrite(). Comment freely if you are not okay.

Power is required for the Node MCU as well as the L298N. It will be better by using a different
supply for the two things. Give 5V from the power bank at the Vin and GND of Node MCU.
You can use 9V or 12Vfor L298N. The whole process is rather easy. See the pic given here and
refer to it with the pinout pic of Node MCU. You will understand it better.

We are going to talk about how to make a WIFI-controlled car using Node MCU. Node MCU
ESP-32S board L298N Motor Drive is mainly used for this. Also, this can be easily controlled
by your smartphone. We have described to you step-by-step how to do this through this

tutorial.



Process of this WIFI Controlled Car

When this WIFI-controlled car is powered on, the Node MCU board connects to the WIFI
connection. Then, when you press the Commands (Forward, Backward, Left, Right) buttons
on the interface created with HTML coding and has live hosted the site, those values will be
sent to the Node MCU board via the web cloud. Then, the gear motors rotate according to
those values. The L298N motor driver board is used for this. Also, the speed of these motors
can be controlled by the slider created on the website.

So, let’s make this smart car step by step. The required components are as follows: -
Used the necessary items and quantity with the help of the above hardware required table.

* Secondly, glue the four gear motors to the car kit board, to do this, use the hot glue gun.

* Thirdly, attach the motor driver board to the top of the foam board. Afterward, connect the
gear motors to the Motor driver board. For that, use the below circuit diagram.

* OK, now glue the breadboard as follows. Then, attach the Node MCU board to the

breadboard
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. Next, connect the motor driver board to the Node MCU board. For that, use the

above circuit diagram.

. Now, connect the battery holder with the GND and 12v terminals on the motor drive
board.

. After, glue it onto the car kit board.

. OK. let’s set up the website. After connecting your device to the WIFI and go to

the link in the

. above “web & app interface made to send commands” page.

. Lastly, attach the batteries to the battery holder and turns ON your smart car. Now,

go to the

. site: - http://wificar.c1.biz/ project and control it easily. OK, enjoy this project.
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Introduction
Overview of Home Automation

Home automation refers to the use of technology to control and manage household systems and
appliances. The concept has evolved significantly over the past few decades, with modern systems
offering advanced functionalities such as remote control, voice commands, and integration with
various smart devices. Home automation aims to enhance convenience, improve energy efficiency,
and provide better security for homeowners. The growing popularity of [oT (Internet of Things)
has further accelerated the adoption of home automation technologies, making it possible to

connect and control a wide range of devices over the internet.
Importance of Home Automation

Home automation offers numerous benefits, making it an essential component of modern living.
Firstly, it provides unparalleled convenience by allowing users to control various aspects of their
homes, such as lighting, heating, and security, from their smartphones or other devices. This not
only saves time but also enhances the overall living experience. Secondly, home automation
improves energy efficiency by optimizing the use of appliances and systems, which can lead to
significant cost savings. For instance, smart thermostats can adjust heating and cooling based on
occupancy and preferences, reducing energy waste. Lastly, home automation enhances security
through features like remote surveillance, automated door locks, and alarm systems, giving

homeowners peace of mind.

Microcontrollers

Microcontrollers are everywhere around us, even when we drive our vehicles, on all computers we
use including smartphones and tablets, or sometimes when making a cup of coffee on our coffee
machines. With the rapid spreading of IoT technology, data is constantly being gathered,

microcontrollers have become a huge part of the modern world with a lot of fields of application.
What is a Microcontroller?

A microcontroller which is also called an MCU or Microcontroller Unit is a single Integrated

Circuit (IC) that is usually used for a specific application and designed to implement certain



specific tasks. This is a small computer based on a single metal-oxide-semiconductor (MOS)
integrated circuit (IC) chip. A microcontroller contains one or more CPUs or processor cores with
memory and programmable input/output peripherals attached to it. Program memory in the form
of ferroelectric RAM, NOR flash, or OTP ROM is also often included on this chip, as well as a

small amount of RAM along it.

“Microcontroller” is a well-chosen name for this apparatus because it emphasizes the defining
characteristics of this product category precisely. The prefix “micro” implies size or the smallness
of the device and the term "controller" here implies the enhanced ability of the device to perform
control functions. The functionality of this device is a result of a combination of a digital processor
and a digital memory with additional hardware components that are specifically designed to help

the microcontroller to interact with the other components.

Microcontrollers are usually designed for embedded applications, in contrast to the
microprocessors which are used in personal computers or other general-purpose applications. They
are essentially simple miniature personal computers designed to control small features of a larger

component, without a complex front-end operating system.

A microcontroller is similar to but less sophisticated than, a System on a Chip (SoC). An SoC may
include a microcontroller as one of its components, but in addition, it is also integrated with

advanced extensions like a graphics processing unit (GPU), a Wi-Fi module, or coprocessors.

By reducing the size and cost compared to a design used on a separate microprocessor, memory,
and input/output devices, microcontrollers make it economical to digitally control even more
devices and processes very easily. Mixed-signal microcontrollers are very common. They function
by integrating analog components needed to control non-digital electronic systems. About the
internet of things and robotics, microcontrollers are an economical and popular means of data

collection, sensing, and actuating the physical world as edge devices.

Microcontrollers generally can retain functionality while waiting for an event like a button press
or some other interrupt. Other microcontrollers may serve performance-critical roles at which they
may need to act more like a digital signal processor (DSP) than a microcontroller, with higher

clock speeds and power consumption.



A microcontroller is also known as an embedded controller. Various types of microcontrollers are
available in the market with different word lengths. It is like a compressed microcomputer
manufactured to control the functions of the embedded systems in appliances machines used in
offices, robots, home appliances, motor vehicles. Microcontrollers are employed in devices that

need a degree of control to be applied by the user of the device in controlling it.

A microcontroller can be also defined as a small and low-cost microcomputer, which is designed
to perform the specific tasks of embedded systems like displaying microwave information,
receiving remote signals, etc. Any electric appliance that stores, measures, displays information,

or calculates comprises a microcontroller chip inside it.

What a microcontroller does is, gathers input, process this information, and outputs a certain action
based on the information gathered by it. Microcontrollers usually operate at lower speeds, around
the IMHz to 200 MHz range, and are designed to consume less power because they normally are

embedded inside other devices that can have greater power consumptions than the MCU.

A Microcontroller can be considered as the backbone of Embedded Systems and its most important
feature is the fact that "It can think". A Microcontroller may look like a simple electronics chip,
but it’s way too powerful because it's programmable. Using a programming code, we can control

all I/O pins of a microcontroller and are used to perform multiple functions.

C and assembly languages are usually used for programming a microcontroller but the HEX File
which gets uploaded in Microcontrollers is in machine language. There are also other languages
available for programming a microcontroller but beginners start with assembly language as it

provides a clear idea about the microcontroller's architecture.
History

The origins stories of both the microprocessor and the microcontroller go back to the invention of
the MOSFET, also known as the MOS transistor. Mohamed M. Atalla and Dawon Kahng at Bell
Labs invented it in 1959. Atalla also proposed the MOS integrated circuit, which was an integrated
circuit chip fabricated using MOSFETs. MOS had higher transistor density and lower
manufacturing costs than bipolar chips. MOS chips increased in complexity with time, leading to

large-scale integration (LSI) with hundreds of transistors on a single MOS chip. The application



ofthe MOS LSI chip was the basis for the first microprocessors when engineers recognized that a

complete computer processor could be contained on a single MOS LSI chip.

The first-ever multi-chip microprocessors, the Four-Phase Systems, and the Garrett Ai Research
MP944 were developed with multiple MOS LSI chips. The first single-chip microprocessor, which
was the Intel 4004, was released on a single MOS LSI chip.

Engineers Gary Boone and Michael Cochran created the first microcontroller in 1971. The TMS
1000, combined read-only memory, read/write memory, processor, and clock on one chip and

mainly targeted at embedded systems.

After that, Japanese electronics manufacturer began producing microcontrollers for automobiles,
including 4-bit MCU s for in-car entertainment, automatic wipers, electronic locks, and dashboard,

and 8-bit MCUs for engine control.

Nowadays microcontrollers are cheap and are also readily available for hobbyists, with large online

communities around certain processors.

Atypical home in a developed country is likely to have only four general-purpose microprocessors
but around three dozen microcontrollers. A typical mid-range automobile has about 30
microcontrollers. They can also be found in many electrical devices such as washing machines,

microwave ovens, and telephones.

Types of Microcontrollers

Microcontrollers

Memory Instruction Set Architecture Manufacturer
Embedded ciscC Princeton
External RISC AVR

Arduino

Types of Microcontrollers




Microcontrollers are classified based on Bus-width, Memory, Instruction Set, Architecture, &

Manufacturer.

Fields where Microcontrollers are used.
Microcontroller has many applications like:
* As a peripheral controller of a PC

* In robotics and embedded systems

* In bio-medical equipment

* In communication and power systems

* In automobiles and security systems

* When implanting medical equipment

* In fire detection devices

* In temperature and light-sensing devices

* In industrial automation devices

* In-process control devices

* When measuring and controlling revolving objects
ESP-8266

ESP8266 is a low-cost Wi-Fi chip produced by Espressif Systems.
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Figure 3-1. Functional Block Diagram

ESP-8266 Chip Block Diagram



* Esp8266 has integrated a Tensilica L106 32-bit RISC processor. It got extra-low power
consumption, which makes this chip very much suitable for small circuits, IOT Projects.

* This chip reaches a maximum clock speed of 160MHz.

* Wi-Fi- 2.4GHz receiver & transmitter

 User programs are stores in SPI flash

* Memory - 32KB instruction RAM

» External SPI Flash 512KB to 4MB typically in some cases 16MB supported according to

the board you chosen
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SPI- is a synchronous serial communication interface via SS SCLK MOSI MISO Pins.
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PWM - way to reduce the power delivered by an electrical signal

ADC-Analog to Digital Converter Converting analog inputs to digital signals



SDI0 Interface Bus:

Clock
MWD
Host Dewlee
Data
Master [=SDA 1
"main" 12C bus
(Arduino / Esp8266) |_ < }
Slave 1 Slave 3
(MCP23017) (MCP23017)

I2C is a serial communication protocol data is transferred bit by bit by a single wire (SDA Line).
SCL is the clock line. It is used to synchronize all data transfers over the I12C bus. SDA is the data

line.

word sedect ‘h;S g
TRANSMITTER - RECEIVER
data SD

TRANSMITTER = MASTER

I2S is an electrical serial bus interface used to connect digital audio devices. Consists of a clock

line, word clock (left-right clock) line, and serial data line.



SDIO (Secure Digital Input/Output Interface) - SDIO is used for Data exchange between host
and device. SDIO can connect the SD Slot with I/O devices like Bluetooth, Wireless LAN, GPS

Receiver, Digital Camera, etc.
Getting Started with NodeMCU
Setting Up the NodeMCU Development Environment

To begin working with NodeMCU, you need to set up the development environment. This typically
involves installing the Arduino IDE and configuring it to work with NodeMCU. The Arduino IDE
is a popular choice for programming NodeMCU due to its user-friendly interface and extensive

library support.

1. Download and Install Arduino IDE: Visit the official Arduino website and download the latest

version of the Arduino IDE for your operating system. Follow the installation instructions.

2. Add ESP8266 Board Manager: Open the Arduino IDE, go to "File > Preferences’, and enter the
following URL in the "Additional Boards Manager URLs" field:
“http://arduino.esp8266.com/stable/package esp8266com index.json’. Then, go to “Tools >
Board > Boards Manager’, search for 'TESP8266°, and install the package.

3. Select NodeMCU Board: Once the ESP8266 package is installed, select 'NodeMCU 1.0 (ESP-
12E Module)" from the "Tools > Board" menu.

Installing the Required Software

After setting up the Arduino IDE, you need to install the necessary libraries to work with

NodeMCU. The following steps will guide you through this process:

1. Install the Blynk Library: In the Arduino IDE, go to "Sketch > Include Library > Manage
Libraries’, search for 'Blynk’, and install the library.

2. Install Additional Libraries: Depending on your project, you may need other libraries such as

‘Adafruit_Sensor” or 'DHT". Follow the same process to install these libraries.



Basic Programming with NodeMCU

Once the development environment is set up, you can start writing and uploading code to

NodeMCU. Here’s a simple example to blink an LED:

“epp

#define LED PIN 2 // Built-in LED pin

void setup() {

pinMode(LED_PIN, OUTPUT);

void loop() {
digitalWrite(LED_PIN, HIGH); // Turn the LED on
delay(1000); // Wait for a second
digitalWrite(LED_PIN, LOW); // Turn the LED off

delay(1000); // Wait for a second

To upload the code, connect the NodeMCU to your computer via USB, select the correct COM
port from "Tools > Port’, and click the upload button.

Introduction to Blynk



What is Blynk?

Blynk is a powerful IoT platform designed to simplify the development of mobile and web
applications for controlling and monitoring hardware remotely. It provides an intuitive interface
for creating custom dashboards, making it easy to build user-friendly applications without
extensive coding. Blynk supports a wide range of hardware platforms, including NodeMCU,

Arduino, Raspberry Pi, and others, making it a versatile choice for IoT projects.

Features of Blynk

Blynk offers a variety of features that make it ideal for home automation and other IoT

applications:
Cloud Service: Blynk’s cloud service ensures real-time data synchronization and remote control.

Blynk App: Available on i10S and Android, the Blynk app allows users to create custom dashboards

with widgets such as buttons, sliders, and graphs.

Blynk Library: Provides a simple way to connect your hardware to the Blynk cloud and control it

using the Blynk app.

Widgets: A wide range of widgets for various functions, including buttons, sliders, LED indicators,

and more.

Notifications: Real-time notifications and alerts based on sensor data or events.

Advantages of Using Blynk for Home Automation

Blynk simplifies the process of building and deploying IoT applications, making it an excellent
choice for home automation. Its drag-and-drop interface allows users to create custom dashboards
quickly, while the cloud service ensures seamless remote control and data synchronization.
Blynk’s extensive widget library and support for multiple hardware platforms provide the
flexibility needed to create sophisticated home automation systems. Additionally, Blynk’s active
community and comprehensive documentation make it easy for both beginners and experienced

developers to get started.



5. Setting Up Blynk

Creating a Blynk Account

To use Blynk, you need to create an account on the Blynk app. Follow these steps:
1. Download the Blynk App: Available on the App Store and Google Play.

2. Create an Account:Open the app and sign up using your email address.

3. Verity Your Email: Check your email for a verification link and follow the instructions to verify

your account.

Setting Up a New Project on Blynk
Once you have an account, you can set up a new project:
1. Create a New Project:Open the Blynk app and tap the "New Project’ button.

2. Configure Project Settings: Enter a project name, select your hardware (e.g., NodeMCU), and

choose a connection type (Wi-Fi).

3. Receive Authentication Token: Blynk will email you an authentication token. This token is used

to link your hardware to the Blynk project.

Understanding the Blynk Interface

The Blynk interface consists of a dashboard where you can add and configure widgets. Key

components include:
Widgets: Drag-and-drop widgets onto the dashboard to create your custom interface.
Settings:Tap on a widget to configure its properties, such as pin assignments and labels.

Play Mode:Switch to play mode to interact with your project in real-time.



Adding Widgets to Your Blynk Project
Widgets are the building blocks of your Blynk project. To add widgets:
1. Open Widget Box:Tap the '+ icon to open the widget box.

2. Select Widgets: Choose widgets that suit your project needs, such as buttons, sliders, and

gauges.

3. Configure Widgets: Assign virtual pins, set labels, and adjust other settings as needed.

6. NodeMCU and Blynk Integration

Connecting NodeMCU to Blynk
To connect NodeMCU to Blynk, follow these steps:
1. Include Blynk Library: Include the Blynk library in your Arduino sketch.

2. Add Authentication Token: Copy the authentication token from your email and paste it into your

sketch.

3. Connect to Wi-Fi: Enter your Wi-Fi SSID and password in the sketch.

Here’s a sample code to get started:
“\opp

#define BLYNK PRINT Serial
#include <ESP8266WiFi.h>

#include <BlynkSimpleEsp8266.h>

char auth[] = "YourAuthToken";



char ssid[] = "YourWiFiSSID";

char pass[] = "YourWiFiPassword";

void setup() {
Serial.begin(115200);

Blynk.begin(auth, ssid, pass);

void loop() {
Blynk.run();
b
Writing Code to Control NodeMCU Using Blynk

With NodeMCU connected to Blynk, you can control various aspects of your project using Blynk’s

widgets. For example, to control an LED, you can use a virtual button widget:

“epp

#define LED PIN 2

BLYNK_WRITE(V1) {

int pinValue = param.aslnt();

digitalWrite(LED _PIN, pinValue);

void setup() {



Serial.begin(115200);
Blynk.begin(auth, ssid, pass);

pinMode(LED_PIN, OUTPUT);

void loop() {

Blynk.run();

In this example, when the button widget (assigned to virtual pin V1) is pressed, the LED connected

to pin 2 will turn on or off based on the button state.

Testing the Connection

To test the connection between NodeMCU and Blynk:

1. Upload the Sketch: Upload the code to NodeMCU using the Arduino IDE.

2. Open the Blynk App: Ensure your NodeMCU is powered and connected to Wi-Fi.

3. Interact with Widgets: Use the widgets in the Blynk app to control and monitor your NodeMCU.

If everything is set up correctly, you should be able to control your hardware using the Blynk app.
If you encounter issues, check the serial monitor for error messages and ensure your Wi-Fi

credentials and authentication token are correct.

Basic Home Automation Projects



Controlling an LED with Blynk

A simple and effective project to get started with NodeMCU and Blynk is controlling an LED.
This project involves using a button widget in the Blynk app to turn an LED on and off.

Hardware Required:
- NodeMCU

- LED

- Resistor (220 ohms)

- Breadboard and jumper wires

Steps:

1. Connect the LED: Connect the LED to the NodeMCU’s GPIO pin (e.g., D2) with a resistor in

series.

2. Set Up Blynk Project: Add a button widget in the Blynk app and assign it to a virtual pin (e.g.,
V).

3. Upload Code: Use the following code to control the LED:
“opp
#define BLYNK PRINT Serial
#include <ESP8266WiFi.h>

#include <BlynkSimpleEsp8266.h>

char auth[] = "YourAuthToken";



char ssid[] = "YourWiFiSSID";
char pass[] = "YourWiFiPassword";

#define LED PIN 2

BLYNK WRITE(V1) {
int pinValue = param.asInt();

digitalWrite(LED_PIN, pinValue);

void setup() {
Serial.begin(115200);
Blynk.begin(auth, ssid, pass);

pinMode(LED_PIN, OUTPUT);

void loop() {

Blynk.run();

4. Test the Project: Use the Blynk app to control the LED. The LED should turn on or off based on
the button state.

Monitoring Temperature and Humidity



Another practical home automation project is monitoring temperature and humidity using a

DHT11 or DHT22 sensor and displaying the data on the Blynk app.

Hardware Required:
- NodeMCU
- DHT11/DHT22 sensor

- Breadboard and jumper wires

Steps:
1. Connect the Sensor: Connect the DHT sensor to the NodeMCU (e.g., data pin to D4).
2. Set Up Blynk Project: Add value display widgets in the Blynk app for temperature and humidity.
3. Upload Code: Use the following code to read sensor data and send it to Blynk:
D
#define BLYNK PRINT Serial
#include <ESP8266WiFi.h>
#include <BlynkSimpleEsp8266.h>

#include <DHT.h>

char auth[] = "YourAuthToken";
char ssid[] = "YourWiFiSSID";
char pass[] = "YourWiFiPassword";
#define DHTPIN D4

#define DHTTYPE DHT11



DHT dht(DHTPIN, DHTTYPE);

BlynkTimer timer;

void sendSensor() {
float h = dht.readHumidity();
float t = dht.readTemperature();
Blynk.virtualWrite(V35, t);

Blynk.virtualWrite(V6, h);

void setup() {
Serial.begin(115200);
Blynk.begin(auth, ssid, pass);
dht.begin();

timer.setInterval(2000L, sendSensor);

void loop() {
Blynk.run();

timer.run();



4. Test the Project: Monitor the temperature and humidity on the Blynk app. The sensor readings

should update every few seconds.

Creating a Smart Door Lock

A more advanced project involves creating a smart door lock using a solenoid lock and a relay

module. This project allows you to control the door lock remotely via the Blynk app.

**Hardware Required:**

- NodeMCU

- Solenoid lock

- Relay module

- Breadboard and jumper wires
Steps:

1. **Connect the Hardware:** Connect the solenoid lock to the relay module and the relay module

to the NodeMCU (e.g., control pin to D3).
2. **Set Up Blynk Project:** Add a button widget in the Blynk app for controlling the lock.
3. **Upload Code:** Use the following code to control the lock:

“opp

#define BLYNK PRINT Serial

#include <ESP8266WiFi.h>

#include <BlynkSimpleEsp8266.h>

char auth[] = "YourAuthToken";



char ssid[] = "YourWiFiSSID";
char pass[] = "YourWiFiPassword";

#define RELAY PIN D3

BLYNK WRITE(V2) {
int pinValue = param.asInt();

digitalWrite(RELAY _PIN, pinValue);

void setup() {
Serial.begin(115200);
Blynk.begin(auth, ssid, pass);

pinMode(RELAY PIN, OUTPUT);

void loop() {

Blynk.run();

4. Test the Project: Use the Blynk app to control the solenoid lock. The lock should engage or

disengage based on the button state.



Advanced Home Automation Projects
Smart Lighting System

A smart lighting system can automatically adjust lighting based on ambient light levels and user

preferences. This project involves using light sensors and relays to control multiple lights.

Hardware Required:

- NodeMCU

- Light sensor (e.g., LDR)
- Relay modules

- LED lights

- Breadboard and jumper wires

Steps:

1. Connect the Light Sensor and Relays: Connect the light sensor to an analog pin (e.g., AO) and
the relays to digital pins (e.g., D1 and D2).

2. Set Up Blynk Project: Add widgets for controlling and monitoring the lights.

3. Upload Code:Use the following code to control the lights based on ambient light levels:
“opp
#define BLYNK PRINT Serial

#include

<ESP8266WiFi.h>



#include <BlynkSimpleEsp8266.h>

char auth[] = "YourAuthToken";
char ssid[] = "YourWiFiSSID";
char pass[] = "YourWiFiPassword";
#define LIGHT _SENSOR_PIN A0
#define RELAY1 PIN DI

#define RELAY2 PIN D2

BlynkTimer timer;

void controlLights() {
int lightLevel = analogRead(LIGHT SENSOR_PIN);
if (lightLevel < 500) {
digitalWrite(RELAY1_PIN, HIGH);
digitalWrite(RELAY2_PIN, HIGH);
} else {
digitalWrite(RELAY1_PIN, LOW);

digitalWrite(RELAY2 PIN, LOW);

void setup() {



Serial.begin(115200);
Blynk.begin(auth, ssid, pass);
pinMode(RELAY1 PIN, OUTPUT);
pinMode(RELAY2 PIN, OUTPUT);

timer.setInterval(1000L, controlLights);

void loop() {
Blynk.run();

timer.run();

4. Test the Project: The lights should turn on or off based on the ambient light levels and user
controls in the Blynk app.

Home Security System

A home security system can include motion detectors, cameras, and alarm systems. This project

demonstrates how to use PIR sensors to detect motion and send alerts via Blynk.

Hardware Required:
- NodeMCU
- PIR sensor

- Buzzer or alarm



- Breadboard and jumper wires

Steps:

1. **Connect the PIR Sensor and Buzzer:** Connect the PIR sensor to a digital pin (e.g., D5) and

the buzzer to another pin (e.g., D6).
2. **Set Up Blynk Project:** Add widgets for monitoring motion and controlling the alarm.
3. **Upload Code:** Use the following code to monitor motion and trigger the alarm:
“epp
#define BLYNK PRINT Serial
#include <ESP8266WiFi.h>

#include <BlynkSimpleEsp8266.h>

char auth[] = "YourAuthToken";
char ssid[] = "YourWiFiSSID";
char pass[] = "YourWiFiPassword";
#define PIR_PIN D5

#define BUZZER PIN D6

void setup() {
Serial.begin(115200);
Blynk.begin(auth, ssid, pass);
pinMode(PIR_PIN, INPUT);

pinMode(BUZZER_PIN, OUTPUT);



void loop() {
Blynk.run();
int motionDetected = digitalRead(PIR PIN);
if (motionDetected) {
digitalWrite(BUZZER PIN, HIGH);
Blynk.notify("Motion detected!");
} else {

digitalWrite(BUZZER_PIN, LOW);

Test the Project: When motion is detected, the buzzer should sound, and you should receive a

notification on the Blynk app.

Automated Watering System for Plants

An automated watering system uses soil moisture sensors to monitor soil moisture levels and

control water pumps to irrigate plants as needed.

Hardware Required:
- NodeMCU

- Soil moisture sensor



- Water pump
- Relay module

- Breadboard and jumper wires

Steps:

1. Connect the Soil Moisture Sensor and Relay: Connect the soil moisture sensor to an analog pin

(e.g., AO) and the relay to a digital pin (e.g., D7).
2. Set Up Blynk Project: Add widgets for monitoring soil moisture levels and controlling the water
pump.
3. Upload Code: Use the following code to control the water pump based on soil moisture levels:
epp
#define BLYNK PRINT Serial

#include <ESP8266WiFi.h>

#include <BlynkSimpleEsp8266.h>

char auth[] = "YourAuthToken";
char ssid[] = "YourWiFiSSID";
char pass[] = "YourWiFiPassword";
#define SOIL_SENSOR_PIN A0

#define RELAY PIN D7

BlynkTimer timer;



void controlWaterPump() {
int soilMoisture = analogRead(SOIL_SENSOR _PIN);
if (soilMoisture < 300) {
digitalWrite(RELAY _PIN, HIGH);
} else {
digitalWrite(RELAY PIN, LOW);

}

Blynk.virtualWrite(V3, soilMoisture);

void setup() {
Serial.begin(115200);
Blynk.begin(auth, ssid, pass);
pinMode(RELAY_PIN, OUTPUT);

timer.setInterval(10000L, controlWaterPump);

void loop() {
Blynk.run();

timer.run();



4. Test the Project: The water pump should activate when soil moisture levels are low and turn off

when adequate moisture is detected.

Case Study: Comprehensive Home Automation System
Project Planning

A comprehensive home automation system integrates multiple functionalities, such as lighting,
security, and climate control, into a cohesive system. Planning involves defining the scope,

identifying required components, and setting project milestones.

Objectives and Scope:

- Automate lighting based on occupancy and time of day.

- Monitor and control home security systems remotely.

- Manage indoor climate using smart thermostats and sensors.

- Integrate voice control for added convenience.

Required Hardware and Software

Hardware:

- NodeMCU modules

- Various sensors (PIR, temperature, humidity)
- Actuators (relays, motors)

- Smart devices (thermostats, cameras)

Software:



- Arduino IDE
- Blynk app and library

- Additional libraries for specific sensors and actuators

Implementation Steps

1. Design System Architecture: Define how each component will interact within the system. Create

wiring diagrams and flowcharts.
2. Assemble Hardware: Set up the physical components based on the system design.

3. Develop and Test Code: Write code for each subsystem (lighting, security, climate control) and

test individually.

4. Integrate Subsystems: Combine code for all subsystems and ensure they work together

seamlessly.

5. Set Up Blynk Dashboard: Create a comprehensive dashboard with widgets for controlling and

monitoring each subsystem.

Testing and Debugging

Testing involves verifying that each subsystem functions correctly both independently and as part
of the integrated system. Debugging common issues, such as connectivity problems or sensor

malfunctions, is crucial to ensure reliable operation.
Final Deployment

Once testing is complete, deploy the system in the actual home environment. Ensure all
components are securely installed and perform final tests to verify functionality. Provide a user

manual for operating the system and offer maintenance tips.



Troubleshooting and Debugging
Common Issues with NodeMCU

1. Connectivity Problems: Ensure correct Wi-Fi credentials and check for network stability. Use

serial monitor for debugging connection issues.

2. Power Supply Issues: NodeMCU requires a stable 3.3V power supply. Use a dedicated power

source if necessary.

3. Flashing Errors: Verify correct board and port settings in the Arduino IDE. Check USB cable

and drivers.

Common Issues with Blynk

1. Widget Configuration Errors: Ensure widgets are assigned to the correct virtual pins. Double-

check widget settings in the Blynk app.

2. Server Connectivity Issues: Ensure NodeMCU has internet access. Check Blynk server status

and try reconnecting.

Debugging Tips and Tricks

1. Use Serial Monitor: Print debug messages to the serial monitor to trace code execution and

identify issues.

2. Modular Code Development: Develop and test code in small modules to isolate and fix issues

more easily.

3. Community Resources: Utilize forums, documentation, and tutorials for troubleshooting tips

and best practices.

Future of Home Automation

Emerging Trends



1. Al and Machine Learning Integration: Advanced algorithms for predictive maintenance, energy

optimization, and personalized user experiences.

2. Voice Control and Smart Assistants: Increasing integration with voice-controlled devices like

Amazon Alexa and Google Assistant.

3. Enhanced Security Features: Improved encryption and security protocols to protect against

cyber threats.

Potential Upgrades

1. Adding More Sensors and Devices: Expand the system with additional sensors for air quality,

water leakage, etc.

2. Enhancing Security Features: Implement advanced authentication methods and data encryption

for secure communication.

3. Improved Energy Management: Integrate smart meters and energy monitoring tools for better

energy management.

Integration with Other Smart Home Devices

1. Compatibility with Existing Systems: Ensure interoperability with other smart home platforms

and devices.

2. Expanding the Ecosystem: Integrate with third-party services and platforms for enhanced

functionality and convenience.
Conclusion
Summary of Key Points

This report has covered the fundamentals of NodeMCU and Blynk, their roles in home automation,
and detailed guides for setting up and implementing various home automation projects. We
explored basic and advanced projects, from simple LED control to comprehensive smart home

systems, emphasizing the ease of integration and the power of these platforms.



Final Thoughts on NodeMCU and Blynk in Home Automation

NodeMCU and Blynk together form a robust, versatile, and cost-effective solution for home
automation. Their combined strengths in connectivity, ease of use, and flexibility make them ideal
for both beginners and experienced developers. As the IoT landscape continues to evolve, these
platforms will remain pivotal in driving innovation and expanding the possibilities of smart home

technologies.
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